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File Menu Commands

Open
Opens an existing calendar file.

Save
Saves the current calendar settings and overlay filenames to the active calendar file.

Save As...
Displays a standard Save As dialog to save the current calendar settings and overlay filenames to a 
new calendar file.

Page Layout...
Used to define the page orientation, header/footer settings, and page margins (see Printing).

Print...
Instructs Almanac to send calendar or schedule information to the printer (see Printing).

Change Printer...
Used to select and configure a target printer.

Set Wallpaper
Selecting this option causes Almanac to install a background image of the current contents of 
Almanac's Main window onto the Window's desktop.

Exit
Closes the Almanac program.



Edit Menu Commands

The Edit menu is used to edit text within the Notes window.

Undo
This option becomes available after any changes have been made to the text in the Notes window.    
Selecting it will undo the last change which was made to the text.

Cut
Removes the currently selected text in the Notes window and places it in the Windows clipboard.

Copy
Copies the currently selected text in the Notes window to the Windows clipboard.

Paste
Pastes text from the Windows clipboard into the Notes window at the current entry point.

Clear
Deletes the currently selected text in the Notes window.



Options Menu Commands

The Options menu contains selections which allow you to customize the appearance and operation of the 
calendar and accessories.

All options are saved in the calendar file and restored when the file is re-opened.

Calendar...
Activates the Calendar Options dialog.    Used to set options for the calendar operation of the Main 
window.

Scheduler...
Activates the Scheduler Configuration dialog.    Used to configure the Scheduler tool window.

ToDo...
Activates the To-Do Configuration dialog.    Used to configure features of the To-Do tool window.            

Phonebook...
Activates the Phonebook Options dialog.    Used to configure features of the auto-dial feature of the 
phonebook.

Exporting or importing of CSV (comma separated value) phone and address data is also available 
through the Phonebook Options dialog.

Overlays...
Activates the Calendar Overlays dialog to configure or edit overlay information for the current calendar.

Colors...
This selection activates the Almanac Color Settings dialog.    Used to customize Almanac's on-screen 
display.

Directories...
Used to view or change disk directories used in Almanac.

The Default Overlay Path is used to initialize the file open dialog when opening overlay files.

The Data Base Path is used to store all information entered into the Notes, Scheduler, ToDo, and 
Phonebook tool windows.    Almanac's SETUP utility initially creates a directory named "ALD" for this 
purpose (located underneath the path that you installed Almanac to).

To manage more than one set of information with Almanac, first create a new file directory that will be 
used to contain your new data base of information.    You must do this outside of Almanac using File 
Manager, DOS, or another disk utility.    For example, create a directory named ALD2.

After creating the new directory, enter the name into the Data Base Path control in the Directories 
dialog to begin maintaining a brand new set of appotinments, notes, etc... in the new location.    It is a 
good idea to perform a Save As... from Almanac's File menu at this point.    You can then create yourself
a brand new calendar file that contains all of your current settings including the new data base path you
just entered.

Fonts...
Activates the Almanac Fonts dialog to change screen and/or printer fonts.



Icon Clock...
Almanac can minimize itself to a desktop clock rather than a regular Windows icon (see Icon Clock 
under Running as an Icon).

A check mark next to this selection indicates that the iconic clock is currently configured.

Selecting Icon Clock will activate the Almanac Icon dialog to allow the iconic clock to be 
enabled/disabled and to reveal more options.

Location...
Activates the Current Location dialog used to select a geographical location.    This information is used 
by Almanac to calculate time zones, sunrise and sunset time, and phases of the moon.

The pre-defined geographical data used by Almanac resides in the location data base file, 
ALMLOCN.DAT.    The file is in plain ASCII text format. It can be edited using Windows NOTEPAD or 
any other ASCII text editor to customize it with any locations you would like.

Each record in the file contains an entry for a location name, its latitude and longitude, the standard 
time zone and its offset from GMT.    Optionally, a daylight time zone and the earliest beginning and 
ending dates for the time changes can be entered at the end of each record.

Sound...
Activates the Almanac Sound Setup dialog, used to associate digital sound files to Almanac's audible 
alarms.

Wallpaper...
Invokes a dialog used to direct Almanac to automatically set Windows' wallpaper when Almanac is 
started.    Almanac can set the wallpaper to any of the views provided by its Main window.

Note: Almanac can only set the wallpaper when it is started in normal or maximized modes.    It 
cannot set the wallpaper when it is started minimized as an icon.



Main Menu Commands
Selections on this menu are related to Almanac's Main calendar window.

Year View
Places the Main window into year display mode.

Month View
Places the Main window into month display mode.

Day View
Places the Main window into day display mode.

QuickEdit...
Acitvates the QuickEdit dialog for the current date.

Date...
Acitvates a dialog that prompts for the desired month, day, and year to move to.

Today
Used to move to today.

(Mouse users can double-click anywhere on the surface of Almanac's tool bar to quickly reset to today).



ToDo Menu Commands

View Pending / View All
These two options are used to set the visibility of items in the To Do window list box.

Select View Pending to limit the list to active items, and optionally only those itmes which have not yet 
been completed (To Do Item dialog; Activate Date).

Select View All to include all defined items in the list.    Useful for accessing items which are not 
currently active.

Add
Used to add items to the To Do window.    The keyboard equivalent of the To Do window's "+" tool 
button.

Modify
Used to edit the currently selected item in the To Do window.    The keyboard equivalent of double-
clicking on an entry in the To Do list box.

Check Complete
Used to mark the currently selected item of the To Do window as completed.    The keyboard equivalent 
of the To Do window's check mark tool button.

Archive
Used to archive the currently selected item of the To Do window.    The keyboard equivalent of the To Do
window's file cabinet tool button.



Window Menu Commands

The Window menu is provided for keyboard users.    Almanac's tool buttons provide these functions for 
the mouse.

Launch Notes / Schedule / ToDo / Phonebook
These four selections are used to create the Notes, Scheduler, ToDo, and Phonebook tool windows.

If any of these selections is unavailable (grayed), the tool window is already active.    It may be covered 
by another window.    In this case you should find the tool window listed on the bottom of this menu.    
Select this entry to bring the window to the top and/or reactivate a minimized tool window.

Reset Desk
Used to reset the state of Almanac's desktop to that which was last saved in the current calendar file..

1 Main / 2 (tool window) / 3 etc...
The bottom area of the Window menu is used to track all of the active windows within Almanac.

The active window will be checked.    Select any of the other entries to activate and restore another 
window.



Help Menu Commands

Contents
Used to enter Almanac Help at the Table of Contents

Seach for Help on...
Used to access Almanac Help by searching keywords.

How to Use Help
Use this selection to get Help on Windows Help.

About Almanac...
Displays a standard Windows About... dialog for Almanac.





Calendar Options dialog

This dialog, accessed from the Options.Calendar menu selection, is used to set options for 
the display and operation of the Main window.

Mode
Almanac's internal calendar engine is based upon the modern Gregorian calendar.    This 
combo box is used to choose one of three modes that Almanac can emulate on your 
display and printer.    You can select either the standard Gregorian calendar, the Jewish 
calendar, or a hybrid Gregorian/Jewish format.

Week Begin
Sets the day of the week that appears leftmost in Almanac's calendars.

Red Letter Days
Can be used to cause the numerals of Saturday and/or Sunday to be displayed in red.

Prior/Next Months
Used to control the display of the small calendars in the upper left and right corners of the 
month calendar.

The calendars can be viewed for convenience, or turned off to provide more room for the 
date cells of the calendar.

Notes on month
A musical note symbol will be displayed in a monthly date cell when General Notes have 
been attched to the date.

Time Changes
Transitions from standard time to daylight savings time are marked on the calendar when 
this option is checked.

Moon Phases
Checking this option will display graphics for the four phases of the moon on the month 
calendar display.    The day display also lists the local time of transition for each phase.

Daily Almanac
Checking this option will include sunrise and sunset information (and moon phase data, if 
selected) on the Main window day view.

Daily Julian Day
Selecting Daily Julian Day will display the current Julian date, followed by the number of      
days that are remaining in the current year.    The information appears at the top left 
corner of the Day View, and in the header area of all day binder printouts.

Calendar Week
Selecting Calendar Week will display the current week number based upon the Gregorian 
calendar.    The information appears in the top right corner of the Day View, as well as the 
header area of all day binder printouts.



Scheduler Configuration dialog

This dialog, accessed from the Options.Scheduler menu selection, is used to configure 
options for the Scheduler tool window.

Increment Minutes
Selects the resolution of the time divisions along the left side of the Scheduler window.

The distance between each increment is set to the height of the Tool font.

Summary Bar
The Summary bar appears at the right side of the Scheduler window.    Rectangles mark 
events which occur between its start and end hours.    A dark rectangle half the width of 
the summary bar marks the period currently displayed in the main area of the Scheduler.

Start Hour
The initial hour of the day displayed on the summary bar.

End Hour
The last hour of the day displayed on the summary bar.

Initial Hour
Sets the time that the Scheduler is initially positioned to when a date change occurs.

This time is not used for the current day (today), where the Scheduler will position itself to 
the current hour.

Default Alarm
The number of minutes that the alarm time is initialized before an event.

This is only a default setting, alarms can be adjusted for each event.    The value should be 
zero or negative.



To-Do Configuration dialog

This dialog, accessed from the Options.ToDo menu selection, is used to configure options for 
the To-Do tool window.

Sort Sequence
The To-Do tool list box of items can be sorted in one of two ways:

1) Sorted by priority then by required date (all priority one items appear in ascending 
date sequence followed by all priority two items, etc...).

2) Sorted by required date then by priority (items are listed according to when they are 
due, with higher priority items listed before lower priority items required by the same 
time).

Remove completed items after __ days
Almanac will automatically remove items from the to do list which have been marked as 
completed.    Set the number of days that you wish items to continue appear on your to do 
list after they have been completed.

Archive to-do items removed by Almanac
To do items can optionally be removed from the to do list and recorded to an ASCII text file
(TODO-HST.TXT) when they have been completed, a process called archiving.    Selecting 
this option will archive completed items that Almanac automatically removes from the to 
do list.



Phonebook Options dialog

This dialog is used to configure modem and telephone access information for the auto-dial 
feature offered by the Phonebook tool window.    Your system must be equipped with a 
Hayes compatible modem.    The Port and Port Speed should be set to the values used by 
your modem.    Set the Dial type to either tone or pulse (rotary dial) according to your local 
telephone system.

Long Dis.    Access
Enter the digits used to specify a long distance call.    For example, in North American 
countries a '1' is used to dial long distance phone numbers.

Local Area Code
Enter the local area code.    Almanac uses this information to distinguish local phone 
numbers from long distance numbers.

Dial Out Prefix
Enter any digits that must be dialed to access an outside telephone line.    Many company 
PBX telephone systems require a '9' to be dialed in front of any outgoing telephone calls.

Almanac examines a telephone number before attempting to auto-dial.    If the length is 
greater than 8 digits, the number is scanned to determine if the beginning digits match the 
Local Area Code.    If so, the call is dialed as a local call by first stripping off the area code, 
and then inserting the Dial Out Prefix, if present.    If the Local Area Code search fails, the
call is dialed as a long distance call by inserting any Long Dis. Access digit(s).

Data Conversion
Almanac can import or export phonebook data in CSV (comma separated value) format.    
Select a pushbutton function, and Almanac will display a file open/save dialog to allow you 
to select the *.CSV filename that you would like to read or write. (see CSV Import/Export)



CSV Import/Export

Comma Separated Value format refers to an ASCII text file that contains records of 
information.    Each line of text in the file defines one complete entry.    The line of text is 
composed of the values for each field of the entry, and each field is separated by a comma.

If a comma must appear within a field, the entire field is enclosed in quotation marks.    
Commas may be entered without data following them to describe empty fields.

For example:

"Jim Joyce, Jr.",(909) 555-1234,,Vendor,

The text above illustrates five fields that compose one record. or entry.    Note that the 
trailing comma implies an empty field at the end of the record.

Importing to the Phonebook
Almanac contains a very simple CSV processor.    Every record that is read from a CSV 
import file must contain a complete set of sixteen input values for a phonebook entry.    
The values on each line of text must appear in the following order:

1. Category      (REQUIRED)
2. Last Name      (a Last Name OR a Company Name is REQUIRED)
3. First Name
4. Salutation
5. Title
6. Company Name
7. Address Line 1
8. Address Line 2
9. City
10. Region
11. PostalCode
12. Country
13. Business Phone
14. Home Phone
15. FAX Phone
16. Other Phone

A text file that is written in the format described above can be imported directly into 
Almanac by selecting Options.Phonebook..., and then choosing "CSV Import..."

Exporting from the Phonebook
Select Options.Phonebook..., and then choose "CSV Export..." to write the current contents 
of the phonebook to a CSV    formatted file.    Almanac will include a header record with 
titles for each field to help assist in moving the data into another application.



Calendar Overlays dialog

This dialog, accessed from the Options.Overlays menu selection, is used to control the 
overlays that display holidays, anniversaries, and other events on the calendar.

Active Overlays
Displays the overlay files which are active for the current calendar.    This list can be 
maintained using the control buttons located to its right.

Double-clicking on an overlay file appearing in the list is the same as pushing the Edit 
button.

Selection Pathname
This read only edit box displays the drive and directory of the currently selected overlay in 
the Active Overlays list box.

Create
Used to create a new overlay file.    The new overlay file is automatically add to the Active 
Overlays list when it is saved.

Add
Used to add an existing overlay file to your current calendar display.    Activates an Open 
File dialog box to select the overlay file.

Edit
Activates the Edit Overlay dialog used to edit the overlay file which is currently selected in 
the Active Overlays list.

Remove
Removes the overlay file currently selected in the Active Overlays list from the current 
calendar.

Removing an overlay from the current calendar does not delete the overlay file from disk.

Clear All
Clears all overlays from the current calendar.



Almanac Color Settings dialog

This dialog, accessed from the Options.Colors menu selection, allows customization of the 
colors used to display Almanac on screen.

Basic Colors
Contains a selection of standard colors that can be selected for your current video display.  
Some of the colors are pure and some are blends of two colors.

Select a color by clicking on it with the mouse or position to a color and then press the 
space bar.    The color you select will replace the color of the currently selected Almanac 
display area.    The display areas are shown and selected in the illustrator box located in 
the upper right corner of the dialog.

Screen Area:
Used to select the area of Almanac's display to set the color for.    Mouse users can simply 
click on the area of the display in the illustrator box to set the current selection.

Custom Colors
This control maintains sixteen colors of your own choice.    Colors are selected the same 
way as with the Basic Colors control.    (see Define Custom Colors below for creating new 
colors).

Define Custom Colors
Expands the color dialog, revealing controls used to create or edit custom colors.

Custom color controls
The custom color section contains a full complement of controls for mouse and keyboard 
selections.

The large rainbow control is used to blend the color components using a mouse.    The 
thin luminosity control directly to its right is used to select the intensity of the color.    
Make sure this control is not set to either extreme or you will only be able to create black
and white results.

The Red, Green, and Blue edit boxes below the rainbow control provide another way to 
create colors.    Exact color values for each of the red, green, blue (RGB) components can 
be specified.

The Hue, Sat., and Lum. edit boxes are yet a third way of specifying a color.    These 
values correspond to the HLS color model which represents colors and intensities along a
cone shaped formula.

The Color|Solid control displays the currently mixed color and the closest solid (pure) 
color.    Double-clicking on the solid color will cause the custom controls to re-set to 
define the pure color.

Saving a custom color
Choose the Add Color button to cause the current custom color mix to be saved in one of
the Custom Color boxes.



Almanac Fonts dialog

This dialog, accessed from the Options.Fonts menu selection, is used to change the screen 
and/or printer fonts used by Almanac.    The screen fonts are selected independently of any 
printer fonts to allow you to choose those best suited for each purpose.

Set Fonts For:
Select either Printer or Display to place the dialog into the desired mode.

Text areas:
Contains entries for the various areas that Almanac can use a different font.    The areas 
each one affects are:

Month and Year Titles (Display)
On month calendars, this is the current month and year centered near the top of the 
calendar.    For year calendars, this is the year displayed above the calendar area.

Month Days and Dates (Display)
This selection includes the day of week headings and date numerals which appear in 
month calendar displays.

Month Event Text (Display)
The text within the date cells of the month display.    Overlay events and schedule 
information are displayed in this area.

Mini Calendars (Last/Next and Year) (Display)
Used for the body of the year calendar display, as well as the prior and next months on 
the month display.

Day Calendar (Display)
This is the font used for the day view calendar display of the Main window.

Almanac will automatically create a bold version of this font to distinguish headings on 
the day view.

Tool Windows (Display)
The font selected for tools is used by all of Almanac's tool windows - the Scheduler, 
Notes, and To-Do list.

Almanac will automatically create a bold version of this font to distinguish headings 
where appropriate.

Printer Fonts
The printer font selections are used almost identically to those for the display.    There are
two exceptions:

(1) Two fonts areas are provided to allow different settings for the body of the year 
calendar, and for the prior/next months in the month calendar.

(2) An additional area called Title is available to select the font used for printing a title as
a headers or footer.





Icon Clock dialog

This dialog, accessed from the Options.Icon Clock menu selection, is used to select the 
option of displaying Almanac as a desktop clock when the program is minimized, instead of 
an icon.    The desktop clock may be placed anywhere on the screen.

Display clock when minimized
Checking this box will cause Almanac to minimize to a desktop clock, and will enable the 
remaining controls in the dialog.

Removing the check will cause Almanac to minimize to a standard desktop icon and will 
disable the Iconic Clock controls.

Always on top
Selecting this option will cause Almanac's desktop clock icon to remain on top of any other
regular desktop windows.    (Windows 3.1.)

Display time (date, day of week)
The last three check boxes in the Iconic Clock section request Almanac to display time, 
date, and/or the day of the week in the desktop clock.    At least one of these items must 
be selected.



Almanac Sound Setup dialog

This option, accessed from the Options.Sound menu selection, is made available if Almanac 
detects the presence of Multi-Media sound extensions in your Windows configuration.    It is 
used to associate digital sound files (*.WAV) with Almanac audible alarms.

Alarm
Contains entries for eight different audible alarms.    Almanac has four internal alarms that 
it can sound.    These internal alarms are used in the absence of multimedia sound.    The 
internal alarms used for alarms one through four are repeated for alarms five through 
eight.

Select the alarm you wish to associate with a digital sound file from this list box.

Test
Plays the currently selected alarm.

Description
Used to attach a description of the alarm.    It will appear in the Scheduler dialog alarm 
combo box.

Possible uses can be to describe the recorded sound (Cuckoo clock) or to describe the type
of event it is used for (Coffee Break).

Sound File
The file name of the digital sound file.    It will contain "None" if the alarm has no external 
file association.

Set File
Displays a file open dialog to allow the selection of a sound file.

Internal
Clears any current sound file association with the alarm (Sound File set to "None").



Almanac Desktop

Almanac uses the Windows Multiple Document Interface (MDI).    The Main document window
is used to display the calendar.    Four additional "tool" document windows are available: a 
notepad, a scheduler, a to-do list, and a phonebook.

The Main window is always active.    It displays calendar information according to the current 
display mode, identified by one of the four calendar mode buttons on the tool bar.    Year, 
month, and day view modes can be selected by clicking on the appropriate tool button or by 
making a selection from the Window menu.

The four tool windows can be activated by either clicking on the appropriate tool bar button, 
or by selection from the Window menu.

Arranging the desktop
Almanac's desktop can be customized to suit individual preferences.    The desktop state can 
then be stored in a calendar file by selecting File.Save or File.Save As... to preserve the 
arrangement.    You can select Window.Reset Desk or click on the reset tool button (located 
at far right on tool bar) to automatically reset to this default arrangement during an Almanac
session.

A discussion of window settings, fonts, and colors follows.    All of these items can be 
configured and saved within a calendar file.

Window Arrangments
The windows which are currently active, their positions, sizes, and states (normal, iconic, 
maximized), are all written to the calendar file when it is saved.

You should position and size the windows to best complement your own use of Almanac.

Save the calendar file using File.Save whenever you would like to reset your default desktop 
to the current configuration.

Display Fonts
Select Options/Fonts... to change the display fonts.    Save the calendar file to make the new 
settings permanent.

Colors
You can change the color of the calendar grid, the highlight rectangle, as well as the theme 
color and shadow used to accent the document windows.    Select Options.Colors... to change
the color configuration.



Desktop Clock

Almanac can be minimized to a clock instead of the normal desktop icon.    The clock 
displays the current time, date, and/or day of week.    To configure the minimized desktop 
clock, select Icon Clock... from the Options menu to activate the Almanac Icon dialog.

A small horizontal window is displayed in the bottom right corner of the screen when 
Almanac is minimized and this option is first selected.    You can position the clock anywhere 
on the desktop that you would like.    Drag the window with the left mouse button, or select 
Move from Almanac's system menu (Alt-Space) and reposition the window using the 
keyboard arrows.





Notes Tool Window

This window is used to attach text to a date, a to-do item, an appointment, or a 
phone/address entry.

The Notes window will display a note page for each type of event as it is highlighted, and 
recall any existing text for that event.    A General Notes page will display for the selected 
day when the Main window is active in the month or day modes.    Pages will appear in the 
Notes window for the selected to-do item when the ToDo window is active,    for the selected 
appointment if the Scheduler window is active, and for the selected entry if the Phonebook 
window is active.    

Enter information into the window as you would in any other Windows text area.    Almanac's 
Edit menu provides all of the standard Windows clipboard controls, including an Undo 
command.

Any text entered into the Notes window is automatically saved to disk when it loses the 
input focus to another window.



General Notes

General Notes are maintained by Almanac for every date.    This area can be used to 
maintain a diary or any other type of information that you would like to track by day.





To-Do Tool Window

This window is used to track items which need to be fulfilled by a certain date (and 
optionally a time).

The To-Do window has a list box that contains to-do items.    Each item will display in the 
Main window in the day view mode on the date that it is due.

Any item that is not completed by its due date will automatically be displayed on 
subsequent dates in the Main window day view until it is completed.

Managing To-Do items
A new to-do item can be entered by clicking on the "+" tool button of the To-Do window tool 
bar, or by selecting Add from the To-Do menu.    Either action will activate the To-Do Item 
dialog.

The check mark tool button is used to mark the currently selected to-do item as being 
fulfilled or completed.    It can also be used to reset an item to incomplete.

The file cabinet tool button is used to archive the currently selected to-do item to the ASCII 
text file, TODO-HST.TXT.

To make changes to an existing item, double-click on the entry in the To-Do window listbox.    
Keyboard users can highlight the item in the list box and then select Modify from the To-Do 
menu.



To-Do Item dialog

Text
Up to forty characters of text describing the to-do item.

Required By
The date (and optionally, the time) that this to-do item must be fulfilled by.

Priority
Used to provide a relative priority level to each item on the list.    The To-Do list can be 
sorted by priority and required by date, or first by date and then priority (see Options.To-
Do).

Activate Date
The to-do item will become pending as of this date.    Can be used together with the View 
Pending option of the To-Do window to automatically post items in the list box beginning 
on their activation date.



Archive (to-do item)
Archiving a to-do item removes it from the To-Do window and creates an entry in the ASCII 
text file, TODO-HST.TXT.    The entry consists of the text of the item and the time and 
date completed.    Any notes attached to the item are deleted at this time (the notes are 
not archived).

Only completed items may be archived. To remove an incomplete item you must edit the 
item and select Remove.



Scheduler Tool Window

This window is used to maintain appointments or to partition time throughout the day.

Time is depicted vertically in both the main area and the summary bar on the right.    Tick 
marks to the left of each indicate the time.    The summary bar displays time across the 
entire day.    The start and end times of the summary bar are configured from Options menu 
(see Options/Scheduler...).    A colored rectangle on the summary illustrates the time period 
which is currently displayed in the main area.

Using the Scheduler window
The main area of the Scheduler can be used to enter and update items.    To enter an event, 
position the mouse cursor in the main area next to the desired start time for the item.    Press
the left mouse button, and the start time will display in the title area of the Scheduler.    If 
you need to adjust the start time, first release the left mouse button and then move the 
cursor either up or down.

To schedule an event at the start time displayed, hold the left mouse button down while 
dragging the cursor down the Scheduler.    Release the mouse button when you reach the 
desired end time.    This will activate the Add Schedule Item dialog.

Updating an Appointment
Double-click on any event in the Scheduler window to recall the information for changes.    
See Changing a Scheduled Item.



Add Schedule Item

Description
Up to forty characters of text describing the appointment or time entry.

Occurs On
The date of the event.    For recurring events, the first date that the other dialog 
parameters apply to.

Recurring
This combo box is used to select a recurring event type.    An entry is included for every 
type of recurring event that can be scheduled based on the Occurs On date.

Start/End Time
Used to change the start and end times of the event.

Alarm On/Off
This check box is used to enable or disable an alarm for the event.

Alarm Time
Used to set the time of the alarm for the event.

Test
Plays the currently selected alarm.

Audio
This combo box is used to select the audio desired for the alarm.    External digital sound 
files can be associated with audio alarms using the Options/Sound... menu selection.

Update through
For recurring event types, this control is used to specify the ending date that the dialog 
parameters apply to.

Display on month
Check this box to have the event displayed in the Main calendar window in the month 
mode.



Changing a Scheduled Item

Almanac can change an individual schedule item, or a range of occurrences for a recurring 
scheduled item.

Recall the scheduled event by double-clicking wherever it appears in Almanac.    Make any 
changes that you wish in the Modify Schedule Item dialog.    Almanac will attempt to re-
schedule an event if changes are made to the time or date fields.

If you would like to change a range of events for a recurring schedule item, recall the first 
occurrence (the earliest date) that you wish to change.    When the Modify Schedule Item 
dialog appears, enter an End Date that will include the last occurrence that you wish to 
(re)schedule or change.    Almanac will always attempt to find existing occurrences of the 
event to update.    A new appointment will be scheduled whenever this search fails.



Entering Dates in Edit Controls

Intelligent edit boxes have been created for entering dates into Almanac.    These edit 
controls do not require verbose entries such as Friday, December 25, 1992.    Much shorter 
entries such as "D 25" can be entered.    Almanac will expand this information when you 
move the cursor out of the edit control.

The short and long date formats you have configured using Windows Control Panel 
(International Settings) are used to display and interpret all dates.

Almanac scans the text entered into a date edit control.    If alphabetic characters are found, 
the information is interpreted against the MDY order of the long format, otherwise the MDY 
order of the short format is used.    You can enter very short abbreviations when specifying a 
date.    For example, if your long format is MDY order, entering J 1 might be expanded to 
Wednesday, January 1, 1992.

Alphabetic days in the long format are always ignored and adjusted to the correct day that 
the remaining information specifies.

The minimum information required is the date of the month.    The current month and year 
will be used when they are not specified in the entry.    Experiment with your own 
"shorthand" entries to find the style that you like best.



Navigating within Almanac

Almanac is designed to provide a flexible system for managing information that is related to 
time.

Almanac's tool windows are linked internally, and will attempt to provide additional 
information for the currently active item whenever possible.    The Scheduler and Notes 
windows will "snap" to the selected date in the Main window.    Similarly, the Notes window 
will provide pages for general notes, scheduled items, to do items, or phonebook entry, 
depending on whether the Main, Scheduler, ToDo, or Phonebook window is currently active.

You can move from one window to another by:
» Clicking on the window's tool button.
» Clicking on the new window with the mouse.
» Pressing Ctrl-Tab.
» Using the Window menu.

Although Almanac provides the capability to minimize any of its windows to icons, the tool 
ribbon buttons provide the quickest access to a tool window no matter what its current state.
They will take the appropriate action to create, activate, and/or restore a window to the 
display.

Almanac windows
Select one of the following to learn more about each:

» Main window
» Scheduler window
» ToDo window
» Notes window 
» Phonebook window                                                                                                                                                 





The Main window
Almanac's Main window provides all of the calendar functions of the program.    It can be 
displayed normal, maximized or minimized (as an icon) within Almanac's frame window, but 
it does not close until Almanac terminates.

The Main window can display several calendar views.    Select the year, month, or day view 
by clicking on the appropriate tool button or by using the Main menu.

Working in the Main window

The following actions can be taken with the mouse in the Main window:

Month view
» Click on any date cell to make it the active date.    If active, the Scheduler and Notes 

windows will snap to the date.
» Double-click over the date numerals of a date cell and the Main window moves to the 

day view for the selected date (same as clicking on day and then on day view tool 
button).

» Double-click anywhere else in the date cell to activate a QuickEdit dialog box for 
updating overlays and schedules.

» Double-click on the previous or next month calendar to move to that month.
» Double-click on the year to move to the year view.
Year view
» Double-click on any month in the year view to move to the month view.
Day view
» Double-click in the Almanac area to enter or edit an overlay item.
» Double-click on any item in the Schedule area to edit it, or on the last (vacant) line to 

enter a new item to the schedule.
» Double-click on any item in the ToDo area to edit it, or on the last (vacant) line to enter a 

new item due on the selected date.

The keyboard can also be used for actions in the Main window:

Month view
» Use the cursor arrow keys to select a date cell.    The Home key moves to the first of the 

month and the End key moves to the last.
» Select Day View from the Main menu to change to day mode.
» Select Enter Event from the Main menu to activate the QuickEdit dialog.
» Use the PgUp and PgDn keys to move to the previous or next month.
» Select Year View from the Main menu to move to the year mode.
Year view
» The cursor keys work as for month mode.    PgUp and PgDn move to the next or last year.
» Pressing Enter while in the year view will move to the month mode for the currently 

selected month.



Zooming a date cell
Press the Shift key when Almanac's Main window is in the month mode to zoom a date cell.
The cell will expand to about four times normal size, revealing information that was not 
visible in the smaller cell.



Running Almanac as an Icon

Almanac provides two special features when it is minimized to an icon.    It can display the 
custom icon and description that you have defined in Program Manager, or it can display a 
digital clock in the lower right corner of your display, and then be moved anywhere on the 
screen.

Custom Icon and Description
Minimizing to a custom icon requires Windows 3.1 Program Manager or a Win 3.1 
compatible shell program.    This option is invoked by specifying a calendar filename to 
Almanac on its command line.    When Almanac is started in this manner, it will load the 
calendar file and attempt to acquire a text description and icon from the Windows shell 
program.    If successful, the new icon and description will be used when Almanac is 
minimized until a File.Open or File.Save As... command is performed.

Iconic Clock
Almanac can be configured to minimize to a digital clock in the lower right corner of your 
display instead of a desktop icon, you may then move the clock anywhere on the screen.    
Select Options.Icon Clock... to access the Almanac Icon dialog.



Overlay Files

Overlay files are used to display information related to a calendar dates.    Common 
examples are holidays, birthdays, anniversaries, etc...

You can create or edit an overlay file by selecting Overlays... from the Options menu.    
Individual overlay entries can also be added or modified through the QuickEdit dialog.

Managing Overlay Files
Definitions for one or more events are stored in each overlay file.    Different types of events 
can be placed into different overlay files to assist in organizing the information.

Up to ten overlay files may be specified in a calendar file.    This allows you to mix and match
the types of events that are required for any calendar need.    A little bit of forethought about
how to best divide your information among overlays will make using Almanac easier and 
more productive.

For example, you may decide to include the birthdays of your relatives into one overlay file, 
while placing friends' birthdays into another.    The more specifically you define the 
categories of your overlay files, the more control and flexibility you will have creating 
calendar files.



Pre-defined overlays
Your Almanac package includes several overlay files that define many standard holidays.    
For example, the file USA_HDAY.ALO contains the most common holidays observed in the 
U.S.      The CHRSTIAN.ALO and JEWISH.ALO files include definitions for holidays observed by 
many Christian and Jewish users.    You can select these and/or other overlay files of pre-
defined events by choosing the Add command from the Options.Overlays dialog.

The overlay files that come with Almanac are not hardcoded tables of information.    They are
simply example files that have been created to save you time and demonstrate how overlay 
files can be used.    You can edit these overlays to meet your own needs.



QuickEdit dialog
The QuickEdit dialog is accessed by double clicking in the Main window date cells, or by 
selecting QuickEdit... from the Main menu.

The dialog displays a list box containing overlay items and/or scheduled items for editing.

Make a selection and choose OK to activate either the Overlay Event or Schedule Item 
dialogs.



Overlay Event dialog
Used to add or modify overlay entries.

Save In
This combo box control is only available when adding a new overlay entry.    Select the 
active overlay file that you wish the event to be saved in.

Text
Up to forty characters of text describing the event.    Some overlay item types require 
specific information.    Birthdays and anniversaries require the name of the person(s) in this
control.

Start/End
This check box is used to request start and end dates for a new event.    It can also be used
to limit which occurrences a change will be applied to, for an existing event.

Occurs On / Start Date
Used to enter the date, or starting date for the overlay definition.

Recurring
This combo box is filled with event types based on the date entered into the Occurs On 
control described above.    Changing the Occurs On date will change the items in the 
combo box.

Some types of recurring events require additional information.    If you select one of these 
types, such as "Every n days," a push button will appear directly to the right of the combo 
box that is user to enter the extra information.

End Date
Only available when the Start/End check box is checked.    Any additions or changes 
entered will be limited up to and including this date.

Accents
Used to activate the Color Accents dialog to highlight an event on the monthly calendar.



Color Accents dialog

The Color Accents dialog is accessible at both the overlay and the overlay item levels.    
Choose "Default Accent..." from the Edit Overlay dialog to define a global accent setting that
applies to all entries in the overlay file.    Choose "Accents..." from the Edit Overlay Event 
dialog to set an accent for an individual overlay item and override any existing global 
accent.

The following controls are located in the group box in the upper right corner of the dialog.

Accent Type
The Pattern selection is always available.    Select Pattern to fill the background of the 
monthly date cell with a solid or pattern color.

The Symbol selection is available for Windows installations which support TrueType fonts.   
Select Symbol to display a TrueType character in the date cell.

Pattern / Symbol
The combo box located directly above Accent Type contains the names of patterns or 
symbols that will display in the monthly date cell.    The choice will be displayed in the date
cell in the selected color.

Color Text
Displays the text of the event in the selected color.

Red Letter
Displays the numerals of any date this event falls on in red.

See the Colors Settings dialog to learn more about the operation of the standard color 
controls.





Using the tool ribbon

The tool ribbon, a horizontal bar containing information windows and tool buttons, appears
directly below Almanac's main menu. 

Date and time windows appear on the left side of the tool ribbon.    These areas always 
display the current time and date.

Tip:    Double-clicking on the surface of the tool ribbon is a mouse shortcut to reset Almanac 
to today's date.

Tool buttons appear to the right, grouped by function.    The first set of buttons control the 
Main window, followed by the tool window buttons, the prior/next buttons, and finally the 
tidy tool button.

Main Window buttons

Year view button.    Places the Main window into year mode.

Month view button.    Places the Main window into month mode.

Day view button.    Places the Main window into day mode.

Tool Window buttons
The tool window buttons will activate a window for either the Scheduler, Notes, ToDo, or 
Phonebook windows.    If the desired tool is behind other windows, it will be brought to the 
top.    If it is minimized to an icon, it will be restored.    If the tool does not yet exist as a 
window or icon, it will be created.

Scheduler tool button.

Notes tool button.

ToDo tool button.

Phonebook tool button.

Prior / Next buttons

These buttons function on the currently active window.

Main window



The window is advanced or backed up according to its current mode (i.e., the calendar 
moves by month in month mode).

Note window
The buttons will change the date if the note window contains general notes, and 
schedule notes.    The buttons are not available for other note types.

Scheduler window
The buttons will change the date of the schedule.

Tidy button

This button will reset the state of Almanac's desktop as it was last saved in the current 
calendar file.





Printing with Almanac

Page Layout Settings
Almanac allows you to set the margins and paper orientation for each printout format.    A 
page header or footer can also be specified.    These settings are accessed from the Page 
Layout dialog by selecting File.Page Layout....

The Page Layout dialog allows access to print settings based upon the currently active 
window.    For example, to change the page layout settings for a year printout, first make 
sure that the Main window is the active window (its title bar is highlighted) and that it is 
currently displaying in year view mode.

An extra check box control is available when defining the page layout for the month 
calendar.    Select the "Size to margins" option to override the normal height-to-width 
proportion used for month calendars.

Sending Output to the Printer
The File.Print... dialog is used to request Almanac to send information to your printer.    Like 
the page layout dialog, this dialog reacts to the currently active window.    To print a month 
calendar, first make sure the Main window window's title bar is highlighted and the Main 
window is in the month view mode.

The print dialog will allow the selection of a time range appropriate for the type of print 
being produced.

When printing a Day Calendar, an additional group box is displayed on the Print Day 
Calendar dialog that allows a choice of a standard list formatted printout or a printout 
formatted for use with day organizer binders.    When the Day Binder type is selected, you 
can choose from several different day binder layouts by choosing the "Layout..." pushbutton.
(see Day Binder Printing)

Some printer settings such as print quality and number of copies can be specified on this 
dialog.    All other print settings are accessible by selecting the Setup pushbutton.

Choosing a Printer or Changing Printer Settings
Select File.Target Printer... to select a different printer or different print settings than your 
Windows default printer.    Note that Almanac will ignore the paper orientation of the selected
printer and use the orientation that was specified in the File.Page Layout... dialog.



Day Binder Printing

Almanac can produce day binder printouts in a variety of sizes.    The formats are based and 
printed on the "Letter" and "A4" paper sizes.

Three different print formats are available for each paper size.

1.    Full page portrait

2.    Half page landscape, one day per page

3.    Half page landscape, two days per page

In North America, the landscape formats can be used to print directly to Laser Organizer 
Pages available from Avery (the label folks).    The Avery part number is 41357.

Printer Limitations
Not all printers can print as close to the edge of the paper as others.    The dual landscape 
format likes to print about 3/10 of an inch up to the right edge of the paper.    Most laser 
printers are able to print even closer than this, but some printers cannot.    Almanac will 
decrease the width of its output to print within the printable area of a printer.

NOTE: At the time of release, the latest printer driver available for the HP Deskjet 500 series
reports a larger printable area to programs than the printer driver will print on the page.    
Users who choose the dual landscape mode and print to a DJ 500 printer will have the right 
edge of the second day print missing until HP corrects this error.    Using the single landscape
format is the only workaround currently available.



Jewish Calendar Features

Almanac's internal calendar engine is based upon the modern Gregorian calendar.    It can 
also calulate and display information based upon the Jewish calendar.    The calendar display 
mode can be set to Gregorian, Jewish, or mixed-mode by selecting Options.Calendar... from 
Almanac's main menu.    Overlay events can optionally be defined based upon a Jewish 
calendar date.

(see Calendar Optionsdialog and Jewish Holidays for more information).



Jewish Holidays
Holidays based on the Jewish calendar can be defined in either Gregorian or Jewish display 
mode.    Almanac will also calculate birthdays and yahrzeits based upon the Jewish 
calendar.    These dates are entered and displayed using the Jewish calendar date.

TIP: If you know the Gregorian date of an event, Almanac will automatically calculate the 
Jewish date for you.    Enter the Gregorian date when defining the event, then choose the 
appropriate Jewish-based event type.      See Overlay Files for more information on how to 
define overlay events.



 Phonebook Tool Window

This window is used to maintain addresses and phone numbers.

Invoke the Phonebook window by clicking on the Phonebook tool window or by selecting 
Launch Phonebook from the Window menu.    An auto-dial function is available in the 
Phonebook tool window.    It must first be configured from the Options menu (see 
Options/Phonebook).

Using the Phonebook window
To enter an address/phone number, select the New button in the Phonebook window.    This 
will invoke the New Phone/Address Entry dialog box.    All fields that have a drop-down arrow 
box, will eventually contain a customized glossary, created by you.    As you enter more 
names and addresss into the phonebook, the process becomes much easier, as you have 
built up a set of terms to be easily referenced with the drop-down arrow boxes.

The Category field must be specified when a new record is entered into the phonebook.    
Also, either the Last Name or Company field must be specified.    All other fields may be used
as required.

Category
Entries into the Phonebook are classified by this field.    When viewing entries in the 
Phonebook window, the Category combo box can be used to limit access to a selected 
category of entries, or can be set to "All" to view your entire phonebook.

Almanac can display phonebook entries either by Individuals or Organizations (companies).   
Selecting "Individuals" will display all entries that have information in the Last Name field.    
Selecting "Organizations" will limit the Name list to entries which include a name in the 
Company field.



Editing a Phonebook Entry
You may edit an entry within the Phonebook, by first selecting the entry, then click the Edit 
button.    Make any desired changes to the Phonebook entry, then select OK.

More Phonebook Features
Almanac will dial telephone numbers appearing in the Office or Home fields, if your system 
is equipped with a Hayes compatible modem. (See Options/Phonebook... ).



Calendar Files

Almanac's File menu includes the familiar Open, Save and Save As selections.    These 
commands operate on calendar files, a file format used by Almanac that allows calendar 
presentations to be customized without changing the underlying data associated with the 
calendar.    The DEFAULT.ALC file (initially created by SETUP) is used to specify the default 
values if a calendar filename is not specified on the command line used to start Almanac.

Calendar filenames use the extension ALC.    These files are used to control (a) where 
Almanac reads and saves calendar data and (b) the presentation format used to display and 
print the data.

Most of the settings that are maintained in a calendar file are accessed from Almanac's 
Options menu.    Additional values are located in the File.Page Layout dialog and the upper 
sections of the Main and ToDo pull down menus.    The settings that you choose affect the 
display and/or printing of your calendar data.    Examine the wide range of options available 
from these menu selections to customize your calendar to your needs and preferences.    
(More information on the File, Options, Main, and ToDo menu selections can be found under 
the Commands... section in the table of contents.)

Select File.Save or File.Save As to store the current settings into a calendar file for easy 
recall.    The current state and position of each of Almanac's windows are also stored into the 
calendar file when a file save is performed.    If you would always like Almanac to save your 
settings in the current calendar file when you close, select the Options.Auto Save on Exit 
setting.

Where Almanac Accesses Data
In addition to specifying values that control the presentation of calendar data, calendar files 
specify where to find the data.    The calendar file points to the data but does not contain the
data itself. The following paragraphs describe how you can create multiple calendar files to 
allow immediate access to different views of the same calendar data or similar views of 
different calendar data.

Calendar data can be entered in the Main and tool windows of Almanac.    This information is 
maintained in (1) overlay files and (2) Almanac data base files.

1)    Overlay files can be added or removed from a calendar display using the 
Options.Overlays dialog.    Up to ten overlay files can be in use simultaneously.    The drive, 
path, and filename for each overlay can be saved in the calendar file.    This feature allows 
overlay files to be created and maintained independently of the calendar file(s) that 
reference it.    It can be used to simply organize your overlay events into different overlays 
by category or, in the case of networked users, to allow many people to view overlays that 
are update at central locations.

2)    All data that is entered into the Scheduler, ToDo, Notes, and Phonebook tool windows is 
stored in data base files that Almanac maintains in a data base directory.    The name of the 
data base directory is controlled from the Options.Directories dialog.Data base files for the 
Phonebook are also stored in the \ALD sub-directory (PHONEBK.ALP).    Notes that are 
attached to entries in the Phonebook are also in the \ALD sub-directory (PHONEBK.ALD).    
They can be easily backed up and/or deleted.    The Almanac SETUP utility creates a sub-
directory called ALD under the directory that Almanac is initially installed to.    

You can create another data base for use by a different calendar file by first creating a new, 
empty sub-directory on a disk drive.    (Almanac will not create a new directory on your disk.   
You can use Windows File Manager or use the MD command from a DOS prompt).    Next, 



specify this new directory in the Options.Directories dialog of Almanac as the Data Base 
directory.      Subsequent data accesses will be performed from/to the new directory.    No 
other initialization is required.    Perform a File.Save or File.Save As to update the new data 
base pathname to the calendar file that you will use to access the new data base.

 




